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Platform development engineers

Purpose
Describes how to develop a Bi o MO B Icdth®d'without the use of the catalog wizard.

Pre-requisites

It is recommended to have read the Developer Guide before reading this.

This document may be read in conjunction with the Block Development from Scratch
Tutorial.
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Note: Bi o MOB1 US A wrhentgefers todhe entire software system for the creation
of Bi o MO B lappikcations, and includes EyesWeb graphical development environment,
the UI development tool, the block libraries, catalogs, etc.

The Bi o MO B Iplatferit also consists of hardware components that are not included in
the scope of this document.

Note: Bi o MO B Iblil@ & the EyesWeb initiative by the University of Genoa. Many of
the technical details of Bi o MO B Ireflegt those of the EyesWeb system.

Bi o MOB | Bpplieations, Eyes Web Patches, Blocks and Catalogs

ABi o MO B lapplgation is built on top of an EyesWeb patch which in turn is made up of
functional el e me n Ea&h biock | ilmpethents, bome cpedfit piece of
functionality. For more information about patches and blocks, see the Architecture
document and the Anatomy of a Block document.

Blocks are implemented as C++ classes in the Microsoft Visual Studio environment.
Their code is stored in DLL files, which are then included in the build process for patches
when the patches are started. The DLL file in which the block code is stored is referred to
as a catalog . In order to create a block, you first need a catalog.

Bi o MOB Iptb@des a wizard to simplify the creation of catalog. However, in some
circumstances it may be preferable to develop the catalog , f r om scr at ch*
use of the wizard. This tutorial presents the process for doing this.

This docum ent explains how to build a simple catalog . It is a copy of the HTML
tutorial.

Simple Catalog

This section explains how to build a simple catalog from scratch, i.e., without using the
EyesWeb wizard.

Prerequisites

This Section provides a step-by-step procedure, starting from scratch. Before you begin to
write and implement your own block, you have to download and install the EyesWeb SDK to
properly include header files, and link the needed library files.

The SDK can be downloaded by accessing the EyesWeb web site at
http://www.eyesweb.org/ or http://www.infomus.dist.unige.it/ or the developers section of
the http://biomobius.trilcentre.org site, and following the links to the EyesWeb SDK
Download pages. Once you have downloaded the latest version of the EyesWeb SDK, you
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simply install it by double-clicking its icon file. This operation installs the necessary header
and library files to your hard disk. The last step you need to take before starting
development of your own catalog is to point to the correct directories of your hard disk,
where you have installed the EyesWeb SDK, in order to make them accessible to the
Microsoft Visual Studio development environment. Hence, you must set these
corresponding values into the "Options..." window from the "Tools" menu, selecting the
"Projects" parameters regarding the "VC++ Directories". The values that must be set are
the "Include Files", "Library Files" and "Output Files", adding to them the correct "Include",
"Lib" and "Bin" directories according to where you have installed the EyesWeb SDK, as
shown in Figure 1.

© Environment Platforrn: Show directories For:
= Projects and Solutions Win32 w Include Files w
General .
Buid and Run v|ex| x| +] ¢
il Defa.ls . $WCInstallDirinclude ~
¥C++ Directories $iVCInstallDirjatimfoiinclude
YC++ Project Settings $WCInstallDirPlatformsDElinchude
¥ Source Comtrol ${FrameworksDEDirinclude
Editor C:\SDK\Evesieb SDK
: [l;:{tl Took C:SDE\Evesiieb SDKAIN
+- Debugging
+ Device Tools
+ HTML Designer w
+ - Windows Forms Designer £ >
Include Directories
Pakh ko use whan searching For include Files while building a YC++ praject,
Corresponds ko environment variable INCLUDE,
K l [ Cancel ]

Figure 1 -The Project options window of Visual Studio

Creating an empty .dll

The first step is to create an empty .dll as shown in the Figure 2. This tutorial is based on a
Win32 .dll; however you could also create an MFC .dll if you plan to use windows and/or
dialogs in your modules. In this example, to create a new project from Microsoft Visual
Studio, you have to choose the "Win 32 Project" icon from within the "New Project..." item
in the "File" menu, and to furnish a project name, then click on the "Ok" button, as shown
in Figure 2.
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Figure 2 - The Micros oft wizard to create an empty dll

As a second step of the wizard, you have to specify that you want to create a .dll by
selecting the appropriate "DLL" item in the "Application Settings". This step is shown in the
following Figure.

Win32 Application Wizard - Simple_Catalog

- 5‘,' } ' Application Settings
Owerview Application kype: Add common header Files For:
application Settings O windaws application Cat

() Cansole application [ Mrc

® Ak

Static librar
Creates a 32-bit Windows DLL application project. l
AdOEGnaT opeans:

|:| Empty project
[ Export symbals

[ Finish ” Cancel ]

Figure 3 - Select the type of project
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Then, you have to click on the Finish button and your empty project will be created. The
created project should contain files SimpleCatalog.cpp , stdafx.h, and stdafx.cpp.

At this point your project, if properly and manually configured, should generate its output
and you will get an empty .dll as final result. This .dll is not a valid EyesWeb .dll yet: you
need to register it with the command line tool EywRegisterModule as explained in the
section catalog_registration. Thus, the next step that you have to do is to add a definition
file to your project, with the "Add New Item..." command of the "Project" menu, as shown
in Figure 4. This file specifies the entry points of your .dll.

Add New Item - Simple_Catalog

Categories: Templates: 88 &
= Visual C++ Visual Studio installed templates o
ul
cﬂd@ T, ; - v
- o
RT‘:E C++File (.cpp)  Header File (.h) Midl File {.idl)
W
Wtility
Property Sheets

d ]

Component Class  Installer Class

My Templates 3
Creates a DLL export definition file -
Name: ImageMoments. DEF

Location: c:\Documents and Settings\pjvance\My Documentsi¥isual Studio 2005\Projects\Simple_Catalog\si| | Browse... |

L_asd J[ conce ]

Figure 4 - Adding the DLL Definition File.

If your dll has a proper signature, it will be considered a valid EyesWeb.dIl. So ensure a file
named SimpleCatalog.def is added to the project; the file will look like this:

; This file defines the functions exported by your dll. It has this fixed format, thus,

; you do not need to change this. Neither you need to define/declare the functions

; listed here, as they are provided by the EyesWeb SDK. All you need to do is to add it
; to your project and to tell the linker to use it via the /DEF:"SimpleCatalog.def"

; command line switch (alternatively, use the "Module Definition File" setting in the

; linker section of the project properties)
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../Tutorial/Tutorial/Tutorial/Output/html/_simple_catalog_8cpp.html

EXPORTS

EywUserDIl_GetSDKVersion PRIVATE
EywUserDII_IsDebugBuild PRIVATE
EywUserDIl_GetDllIdentifier PRIVATE
EywUserDIl_GetDIlILanguageIDCount PRIVATE
EywUserDIl_GetDlILanguageID PRIVATE
EywUserDIl_GetDIISignature PRIVATE
EywUserDIl_SetThreadSpecificPtr PRIVATE

Note : The ,EywUserDIl_SetThreadSpecificPtr exported symbol has been added with
EyesWeb 5.0, thus, you might not see this if you are looking at definition files of block
compiled with an older SDK.

Then, you have to tell the linker that this file is used to specify the exported symbols of
your dll. This is done by setting the properties of your project: edit the properties of your
project (e.g., selecting the "Project SimpleCatalog Properties..." item from the "Project"
menu), and, in the "Linker.Input" Property Page specify your file as the Module Definition
File (see Figure 5).

Simple_Catalog Property Pages @@
Configuration: | ActivelDebug) | Platform: | Ackive(Win32) hd Configuration Manager. ..
4 Common Properties Additional Dependencies
=J- Configuration Properties Ignore All Default Libraries Mo
General Ignore Specific Library
Debugging Module Definition File ImageMoments.DEF v

H O+ add Madule ko Assembly

=|- Linker Embed Managed Resource File
General Force Symbol References
Input Delay Loaded DLLs

Manifest File
X Assembly Link Resource
Debugging

Syskem
Optimization
Embedded IDL
Advanced
Command Line
+- Marifest Taol
+- =ML Document Generatar
= Browse Information
+- Build Everts
+- Cuskom Build Step
+- Wb Deployment

Module Definition File
Use specified module definition file during executable creation,  {{DEF:name)

[ OF ][ Cancel ][ Apply ]

Figure 5 - Tell the linker that SimpleCatalog.def is your Module Definition File

Some other project settings have to be changed from their default value. You have to
specify a dll runtime library, both for the debug and the release versions of your project. To
do this, go to the "C/C++.Code Generation" Property Page and specify ‘Multi-threaded
Debug DLL (/MDd)" for the Debug version and "Multi-threaded DLL (/MD)" for the Release
version in the "Runtime Library" property value (see Figures 6 and 7), then save the
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changes.

Simple_Catalog Property Pages

Configuration: Platform: |Active(Win32) hd | [ Configuration Manager.., ]
Common Properties Enable String Pooling Mo
(=) Configuration Properties Enable Minimal Rebuild Yes {/Gm)
General Enable C++ Exceptions ‘s {[EHsC)
. Debugging Smaller Type Check Mo
B-C/CH Basic Runtime Checks Both (/RTC1, equiv. to /RTCsu)
Gen.er.al ) Runtime Library Multi-threaded Debug DLL {/MDd}
Opfimization Skruct Member Alignment Diefault
reprs - Buffer Security Check es
s ot Enable Function-Level Linking Mo
Language i
Precompiled Headers Enab!e Enhjanced Instruction Set Mak .SEt .
Qutput Files Floating Point Model Precise (ffp:precise)
Browse InFormation Enable Floating Point Exceptions Mo
Advanced
Command Line
Linker
Marifest Tool
¥ML Document Generatar
Browese Information
Build Everts
Custom Build Step
Web Deployment
Enable String Pooling
Enable read-only string pooling for generating smaller compiled code,  (fGF)
[ Ok ] [ Cancel ]
Figure 6 - Change the Code Generati on settings

Simple_Catalog Property Pages

Configuration: |Active(Debug)

V: Elatfarm; |Active(Win32)

s | Configuration Manager, .,

[+ Common Properties Enable String Pooling No
(=) Configuration Properties Enable Minimal Rebuild Yes (/Gm)
General Enable C++ Exceptions Yes (/EHsc)
Debugging Smaller Type Check. Mo
S Default <
G’“FFF' ) Rurtime Library Multi-threaded DLL (/MD)
Optimization Struct Member Alignment Default
Preprocesscr Buffer Security Check Yes
Code Generation ) =
T Enable Function-Level Lunlfnng Mo
Precompiled Headers Enab!e Enhlanced Instruction Set Mot lSet .
Output Files Floating Paint Madel Precise (/fp:precise)
Browse Information Enable Floating Paint Exceptions Mo
Advanced
Command Line
[#) Linker
[+ Manifest Toal
[+ ML Docurient Generator
[+ Brawse Information
[+ Build Events
[#/ Custom Build Step
[+ Web Deplayrment
Basic Runtime Checks
Perform basic runtime error checks, incormpatible with any optimization type okther than debug,  (JRTCs,
JRTCu, [RTCL)

[ o

H Cancel ]upply ]

Figure 7 - Change the Code Generation settings

Other settings are specific of the C++ language, and they must be set for both the Debug
and the Release version of your project. In the "C/C++.Language" Property Page you must
specify that you want to "Force Conformance in For Loop Scope" (Yes/Zc:forScope), and
that you want "Run-Time Type Info" to be enabled (Yes/GR) either for "Debug" and for
"Release" configurations, as shown in Figure 8.
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Simple_Catalog Property Pages

Configuration: | Active{Debug) ~ | Platform: | Active(Win3z) v | | Configuration Manager...]

[#- Common Properties Disable Language Extensions Mo N
(=) iZonfiguration Properties Default Char Unsigned Mo
General Treat wehar_t as Built-in Type Yes
Debugging Force Conformance In For Loop Scope No {/2c:forScope-)
= CfCH+ Enable Run-Time Type Info No {/GR-)

General CpenMP Suppart Yes (/openmp)
Optimization

Preprocessor
Code Generation
Language
Precompiled Headers
Output Files
Brawse Infarmation
Advanced
Carmand Line

[+ Lirksr

[+ Manifest Taal

[+ ¥ML Dacument Gensratar

[+ Browss Infarmation

[+ Build Evants

[+ Custom Build Step

[+ wWeb Deplovment
Disable Language Extensions

Suppresses or enables language extensions,  ((Za)

[ QK l[ Cancel ” Apply

Figure 8 - Some C/C++ language settings.

Another recommended property to be set is the "Detect 64-bit Portability Issues" item in
the "C/C++.General" Property Page that must be set to "No" value.

Finally, you have to change file SimpleCatalog.cpp _ as follows:
First, add a static variable which defines a unique string, as can be seen with

g_dllidentifier . Then, change the body of your DliMain entry point such that it looks like
this:

BOOL APIENTRY DIlIMain( HMODULE hModule,
DWORD ul_reason_for_call,
LPVOID IpReserved

)

First we try to understand why the DIIMain has been invoked.

switch( ul_reason_for_call )

If DlIMain has been invoked due to a dll startup, then we initialize the SDK:
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DLL_PROCESS_ATTACH:
( 'SDKInit( hModule, g_dllIdentifier ) )
FALSE;

Otherwise, if DIIMain has been invoked due to a dll shutdown, we shutdown the SDK:

DLL_PROCESS_DETACH:
SDKDone();

A

Nothing else is needed.

TRUE;

We also have to define an identifier for our catalog. To this aim, we use the
EYW_SIMPLE_CATALOG_ID static variable:

Moreover, we need to provide a name and description for our catalog. To do this we define
the ,simpleCatalog" static variable:

static catalog_class_registrant simpleCatalog(
catalog_class_registrant::catalog_id( g_simpleCatalogld )
.begin_language( EYW_LANGUAGE_US_ENGLISH )

.name( "Simple Catalog" )

.description( "A tutorial catalog" )
.end_language()

)

Now the dll can be built and registered as an EyesWeb plugin. Clearly, since it does not
contain any objects, registering/ unregistering it has no visible effect; however, the dll is
correctly recognized.

Finished
At this stage, blocks can be added to the catalog, either using the block wizard, or by
developing them from scratch.
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Catalog Registration

Before a block can be used in the EyesWeb GDE, its catalog must first be registered with the
GDE.

This is achieved in one of two ways:

Manually - right click on the catalog DLL and select the option:
Register EyesWeb 5.0.1.2 Module

Automatically - create a post build command in Visual Studio as follows:

1. Open the project properties page and drill to:

Configuration Properties->Build Events->Post-Buil Event
2. Enter the command line as:

“$(Bi o MOBIEYSVRRIgR)st er Modul e” “$(Target Pat
3. Enter the description as:

Registering EyesWeb module
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